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Overview
The term Integration, as used in BarTender, simply refers to the process of integrating BarTender
with other software or data sources, which in turn can be used to automate processes in BarTender.
The most commonly automated process is printing; however, there are a number of other processes
you can automate with integrations.
In the past, BarTender used the Commander application to integrate with other software and data
sources. The individual orders that caused BarTender to work with other software were called tasks,
and they were created, listed and managed in the main Commander window.
In BarTender 2016, you can use the new Integration Builder tool to create tasks, called simply
integrations, and easily manage them. Integration Builder is part of BarTender's native answer to all
of your integration needs. For more information, refer to the Integration Builder white paper.
Integration Builder improvements over Commander include:
l

More intuitive and flexible user interface

l

More integration methods to choose from

l

More actions to choose from

l

Better control over integration deployment

Integrations can be easily viewed, modified, deployed and maintained from Administration Console.

Transitioning from Commander to Integration Builder

3

About Commander
Overview
Commander was a freestanding software utility installed with the Automation and Enterprise
Automation editions of BarTender. Commander enabled users to perform automatic printing and
other actions in situations where using command line or ActiveX automation was not possible or not
cost effective.

How Commander Worked
When a system needs to print, it performs a triggering action, such as placing a file in a location of
your choosing on the network, transmitting an e-mail, sending data via RS-232 (a serial port), or
sending information through a TCP/IP socket connection. Commander detected the arrival or
occurrence of these "triggers" and then "woke up" BarTender so it could merge your data into
templates and automatically execute a BarTender print job.
In all Windows environments, Commander could run as an application, or could be configured to
operate as a Windows service that ran whenever your computer was on.
To use Commander, you would create a task list, that caused BarTender to work with other software.
Tasks were created, listed and managed in the main Commander window.
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A task consisted of a trigger and one or more commands.
l

A trigger was a file, email or data transmission detected by BarTender to start the task.

l

A command was the action that BarTender took when it detected the trigger.

While creating tasks, you could use Commander Variables, text tags that were replaced at task
execution time. You could replace items in the trigger file such as the document path and file name,
the text file name, and the IDoc name.
You could create a number of tasks, and then save them in a file called a task list. Next you would run
the task list, causing it to monitor a specified directory for a trigger, and then run the tasks you
created.

Limitations of Commander
While Commander was a powerful application that served as a middleware application to integrate
your custom systems with BarTender, it had many limitations:
l

High resource usage

l

Optimized for use on local systems and networks, rather than the cloud

l

l

Complex user interface that combined design, management and monitoring features into a
single application
Lack of testing mechanism before integrations were deployed into production
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About Integration Builder
Overview
BarTender 2016 introduces a new approach to integration by letting you create highly configurable
integrations that let you connect BarTender's printing capabilities with virtually any enterprise
business operation. Integration Builder lets you build complex integrations from scratch, with a easyto-use and intuitive interface. Administration Console makes it easy to update, deploy and monitor
integrations. Behind the scenes, the BarTender Integration service and Print Scheduler service
execute integrations and ensure that your printing operation is running seamlessly at all times.

How Integration Builder Works
Like Commander, Integration Builder allows you to define trigger events and the actions to execute
when those events are detected. And just like Commander, this could be as simple as detecting the
arrival of a file in a monitored directory and "waking up" BarTender to print a document. Unlike
Commander, Integration Builder is not a freestanding application. It is part of a full "integration
platform", including two native Windows services, which run behind the scenes, and
Administration Console, which allows you to manage integration deployments.
Integration Builder further allows for greater flexibility in creating your integrations with many more
integration methods available, including communicating with clients via TCP/IP, UDP or HTTP and
direct support for SAP, Oracle or IBM WebSphere connectivity.
To use Integration Builder, you create an integration file containing one or more integrations that
causes BarTender to work with other software. Integrations are created and updated in Integration
Builder, and managed in Administration Console.
An integration consists of an integration method and one or more actions.
l

l

An integration method, like a trigger in Commander, is a file, email, data transmission or other
event that, when detected, initiates the execution of a defined action.
An action specifies what you want to happen once the integration method is detected. While
the most common action may be to print a BarTender document, actions can also transform
data, delete, copy and move files, send and receive data, and send emails. An action in
Integration Builder is essentially the same thing as a command used in Commander, but with
Integration Builder, you have a wider range of action choices.

Transitioning from Commander
Integration Builder includes a utility that converts legacy Commander task lists into integration files.
To do so:
1. Open BarTender Integration Builder.
2. From the Start page, click Import Commander Task List.
3. Browse to and select the Commander task list file (*.tl) that you want to import.
4. Click Open to open the file in Integration Builder.
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5. From Integration Builder's Administration tab, select Save As.
6. Name the integration file and click Save to save it as a BarTender integration file (*.btin).
Your new integration file can be deployed at this time.
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Benefits of Integration Builder
BarTender's native integration solution is a new set of utilities and services that completely replaces
the Commander companion application. It has expanded capabilities for communicating with your
company's software applications and increased printing efficiency. This section details the benefits
that Integration Builder has over the legacy Commander.

Intuitive User Interface
Integration Builder's user interface exposes more of the underlying attributes for integrations and
actions making them easily accessible on dynamic property pages.

New Integration Methods
In Commander, there were four available triggers: File, E-mail, TCP/IP and Serial Port. Integration
Builder greatly expands upon the available methods, adding:
l

Web Service Request, which runs actions when a web service is posted to a URL

l

Message Queue, which runs actions when a message is posted to a message queue (MSMQ)

l

Time Schedule, which runs actions at a scheduled time and recurrence interval

l

Database, which runs actions when data in a database is inserted or modified

In addition, Integration Builder adds native support for a number of file systems, including Librarian,
FTP or WebDAV (HTTP) services, and Dropbox.

New Actions
Integration Builder greatly expands upon the number of actions available to you. Now, it is easy to
print a document, transform data, perform file actions, send outgoing data, execute Shell and
PowerShell commands, and perform database manipulation. For a complete list of actions, refer to
the Integrating with Integration Builder white paper or the Integration Builder help system.

New Variables
Variables are predefined text tags that are replaced when an action is executed. Integration Builder
supports a number of predefined global and integration variables, and also makes it easy for you to
create your own.

Deployment Management
You can deploy your integrations from either Integration Builder or Administration Console and you
can specify that the integration is deployed immediately or schedule a date and time that you want it
to be deployed. You can also view past and pending scheduled deployments and edit pending
deployments using either Integration Builder or Administration Console. You can stop and start
deployed integrations using Administration Console.
Integration Builder also lets you create deployment plans, where you can save all of your
integration's deployment settings to a file. This lets you easily schedule deployments for any time of
the day.
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Integration Testing
With Commander, there was no way to test a task without first putting it into production. Now, you
can test each integration you create before you deploy it directly from Integration Builder.

Flexible XML Format
An integration file is simply an XML schema native to BarTender. By using this flexible file format,
integrations can be created and modified programmatically or manually without the use of
Integration Builder.
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Appendix A: Terminology Changes
Although Commander and Integration Builder do many of the same things, some terminology has
changed in Integration Builder, and some new terminology has been added.
Commander

Integration
Builder

Command

Action

The action that takes place when an integration event is detected.

Commander
Script

Print
Command
Script

A Print Command Script is a set of written instructions that the Integration
Service can read and execute. Applications not associated with BarTender
can be set up to initiate an integration event that includes Print Command
Scripts. This allows the application to send the Integration Service
instructions that vary, but that use the same integration method.

Commander
variables

Variables

Text tags that are replaced when the integration is executed.

(No
equivalent)

Deploy

Deploying an integration makes it available to the Integration Service. Note
that "Deploy" and "Start" are not the same. A deployed integration is not
necessarily running; it may be stopped or disabled.

(No
equivalent)

Deployment A Deployment Plan allows you to save all of your integration's deployment
Plan
settings and schedule, and edit them at any time.

Start
Detection

Start

The command to activate the integration file.

Task

Integration

An individual integration that detects an integration event and performs one
or more actions.

Task List

Integration
File

A file containing one or more integrations.

Network
TCP/IP Socket Socket
Trigger
Integration
Method

Definition

An integration that runs actions when data is received over a TCP or UDP
socket connection.
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Appendix B: How To - Commander vs Integration Builder
This is a point-by-point guide on how to accomplish the tasks you used to perform in Commander in
the new Integration Builder.
Commander

Integration Builder

To create a new task

To create a new integration

From the Task menu, select Add to open
the Task Options dialog.

For the first integration in an integration file, click Create New
Integration from the Start view and select your integration
method.
To add additional integrations, click the Integrations button on
the Home tab and select your integration method.

To save a task list

To save an integration file

Click or from the File menu, select Save
or Save As.

Click , or from the Administration tab
Save As.

To change a trigger type

To select an integration method

From the Task Options dialog, select an
option from the Trigger dropdown list.

Delete the existing integration. Add a new one by clicking the
Integrations button on the Home tab and select your
integration method.

To add a new command

To add a new action

From the Command(s) tab of the Task
Options dialog, in the Command Type
column, click the Command Type field to
open a dropdown list and select the
desired command type.

In the Integration pane, select the Actions node. The default
action is Print Document.

, select Save or

To add another action, click to open the New Action dialog.
Select the desired action and click OK.
To remove an action, select its name under the Actions node
and click .

To add a new variable

To add a new variable

From the File menu, select Task List
Options to open the Task List Options
dialog.

In the Integration pane, select the Variables node. Here you
can view predefined integration variables that may be
referenced by any action in the integration.

Click the Variables tab. Here you can enter Under Custom Integration Variables, click Add Variable to
variable names and values for the current create a custom variable for the current integration.
task list.
To select a document to print

To select a document to print

From the Commands tab of the Task
to open the
Options dialog, click

Under the Integration pane, select the Print Document action.
In the Properties pane, under Document, enter or browse for
the desired file.

BarTender Command Actions dialog.
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On the Documents tab of the BarTender
Command Actions dialog, under
Documents to Use, select Files and enter
or browse for the desired file.
To set a printer

To set a printer

From the Commands tab of the Task
to open the
Options dialog, click

Under the Integration pane, select the Print Document action.
In the Properties pane, under Print Option Overrides, enable
Printer. From the dropdown list, select the printer you wish to
use.

BarTender Command Actions dialog.
On the Documents tab of the BarTender
Command Actions dialog, under Printer to
Use, select Specified in Document or
System Printer.
If you selected System Printer, select the
desired printer from the dropdown list.
To specify options for an email trigger

To specify options for an e-mail integration

From the Trigger tab of the Task Options
dialog, when you have E-Mail selected as
the Trigger type, click the Setup button to
open the Internet Mail Setup dialog.

Under the Integrations pane, select the Email Integration. In
the Properties pane, set your email options.

To configure a serial port trigger

To configure a serial port integration

From the Trigger tab of the Task Options
Under the Integrations pane, select the Serial Port
dialog, when you have Serial Port selected Integration. In the Properties pane, set your serial port
as the Trigger type, click the Configure
options.
Port button to open the Configure Port
dialog.
To configure a TCP/IP socket trigger

To configure a network socket integration

From the Trigger tab of the Task Options
dialog, when you have TCP/IP selected as
the Trigger type, click the Advanced
Connection Options button to configure
TCP/IP setup.

Under the Integrations pane, select the Network Socket
Integration. In the Properties pane, set your network socket
options.

To enable a task

To enable an integration

From the main Commander window, check In the Integration pane, select Integration. In the Properties
(enable) the box to the left of the task
pane, set the Start Integration option. Select Automatic or
name.
Manual to enable the integration. If you select Disabled, you
will have to manually change that setting before you can run
the integration.
To run a task or task list

To run an integration file
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From the Detection menu, select Start
Detection. Commander will start detection
for all enabled tasks.

Deploy the integration file. From the Integrations node of
Administration Console, click the Start button next to the
desired integration.
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Related Documentation
White Papers and Manuals
l

BarTender Integration Methods

l

Integrating with BarTender Integration Builder

l

Administration Console

For downloadable versions, visit:
http://www.seagullscientific.com/support/white-papers

BarTender Help System
l

Integration Builder

l

Administration Console: Integrations

l

Commander (version 10.1)
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